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1 Introduction 
This document describes the Scan Pro paper scanning software application. Scanning 
provides a means of converting paper documents into computer files using a hardware 
scanner and a computer workstation as shown in the following figure. You may only 
want to store the scanned files on your local computer. If you have a network you will 
probably store all the scanned files on a network file server so others can access the file. 
Storing your scanned files to an internet record server allows you to share the files with 
people who have internet access. You may have a share point server for storing scanned 
files in an enterprise content management system. 
 

Scanner Computer

Sharepoint Server

Record Server

File Server

DVD’s

 
 
Here are some of the advantages of using a scanning program. 
 

1. Find text in a large amount of documents 
2. Prepare documents for court (Bates Stamping) 
3. Move physical paper to cheaper storage space or remove entirely 
4. Share documents over the internet 
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5. Protect sensitive documents using encryption to make illegal access difficult 
 
The most important part of converting documents into computer readable files is that you 
can harness the power of the machine to process and store, find and distribute 
information better than with the manual process of handling paper documents.  
 
You may wonder how the software works. There are 2 very important functions used to 
create an electronic file. The first part is taking an image (a picture) of each sheet of 
paper using the physical hardware (scanner). The software then runs a process called 
Optical Character Recognition (OCR) that converts the picture to machine readable text. 
Finally the software assembles the information from each page into a Postscript 
Description File (PDF). The PDF file is an electronic file that is a universal standard. You 
or people that share documents with you can get a free Adobe Acrobat PDF viewer 
(www.adobe.com) to look at the documents you have scanned.  
 
There are related products that work with the Scan Pro product that you may find useful. 
Stamp – This product automates the process of stamping the pages of a PDF file 
Label – This product is useful for creating cover sheets when you scan to the web 
 
 
 
 
 
 
 

2 Document History 
 
Document  Author Date Revision Description 
scan Roy Nabel 1/31/2000 Creation 
Scan Roy Nabel 3/11/2009 Complete rewrite. 
Scan Roy Nabel 9/8/2009 Added zone OCR templates 
scan Roy Nabel 12/7/2009 Major reorganization 
scan Roy Nabel 11/11/2011 Added log files 
 
  

http://www.adobe.com/
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3 Install and Uninstall 
To install the program you first download the program from the web. With a browser 
enter www.rco.com into the URL address edit box near the top of your browser. 
 
Click the Download menu item in the upper left of the page as shown in the following 
figure. 
 

 
 
You will see the following screen where you have to click the Scan under the Products 
section. 
 

 
 
Click the Download button and save the program to a local folder on your computer. You 
can then click the setup.msi program to install the software. If you have anti-virus 
software you may have to allow the program. 
 
Once you have installed the software click on the Help menu and click on the Activate 
menu item. 
 
To uninstall the scan software start the windows control panel and then click on the 
Program and Features icon. 
 

 

http://www.rco.com/
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In the Views menu you might want to switch to the Detail view. Scroll down the list until 
you find the Name equal to ScanNet. Click on this item and then click Uninstall. 
 

 

4 Understanding the User Interface 
In the following figure you will see that there are several areas you need to learn in order to 
operate the software. 

 

The following table describes each of the areas. 

 

 

Area Description 
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Menu bar Contains all the scanning commands which you can select with the 
keyboard or using a mouse. 

Combo boxes These are used to control the scanner settings. 
Status The message/status area shows you the progress of the OCR 

conversion and also will post various operator messages. 
Thumbnail After a page is scanned the program will create a small thumbnail 

image and add that image to the thumbnail area located vertically 
along the left side. You can resize the thumbnail area using your 
mouse. 

Image After a page is scan the program put a large image in the image area. 
If you are scanning many pages you might want to set the Image 
area magnification to Fit Height. 

 

Below the menu bar you will see several combo box menus that control the current setup. The 
most used combo box is the tray where you will select Front for scanning just the front side of the 
page or duplex for scanning both sides of the page. 

 

Control Description 
tray  

You can select the scan source of either the tray or the ADF 
All  

This controls how many pages to scan. 
B&W  

You can scan the page in black & white, gray scale or color 
Both  

This controls what page sides to capture (front, back or both) 
8x11 std  

This defines the paper size 
300dpi  

This defines the scanning resolution 

 Image area magnification 
 

If you right click the thumbnail the system will show a menu that allows you to perform common 
quality control (Q/C) operations such as rescan page, delete page and print a page. 
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4.1 Thumbnails 
Why do you have the thumbnail window? 
The thumbnail window gives you an overview of the scanning work you have 
accomplished up to the current time.  
 
Here are some important things you can do with the thumbnail window. 
 
You can get see how many pages you have scanned.  
You can move pages around in case you want to correct the order.  
You can delete one or more pages in case you want to rescan them or perhaps you don’t 
want to include those pages. 
You can pan and zoom around the currently selected image  
 
 
Key Concepts 
To understand the thumbnail window you will want to understand a few items. First 
imagine that you have scanned 50 pages. For each page you scanned there is a 
corresponding thumbnail image ordered just like you scanned starting from page 1 to 
page 50. The thumbnail window can be resized. At a given moment depending on the 
size of the window you will have a certain number of thumbnail images. The vertical 
scroll bar located to the right of the thumbnail window (is visible if the number of images 
is greater than what can fit into the window). At any given time there is ALWAYS the 
active thumbnail. This is the large scanned image to the right of the thumbnail window. 
Note that this image may not be visible in the thumbnail window if you have just used the 
vertical scroll bar. There is also an active cursor location that is always visible. 
 
The following are helpful indicators. 
 
Symbol Indicator Description 
Active 
Thumbnail 

Green Border There is only one active thumbnail displayed and this is the 
image displayed in the main window located to the right of 
the thumbnail window. 

Selected 
Thumbnail(s) 

Red Border After you select one or more thumbnails and then select the 
Edit-Cut operation the system will highlight the selected 
images in red 

Drop Zone Blue Vertical Used to indicate the drop position when you drag selected 
thumbnails. This is always a vertical blue bar in front of or 
after a thumbnail image. There is ALWAYS only one drop 
zone. 

Active 
Cursor 
Position 

Yellow Page 
Number 
Background 

Shows the current cursor position. The page numbers are in 
black and the background is yellow. There is ALWAYS only 
one active cursor position. The active cursor is always visible. 
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4.1.1 Basic Operations 
The process of selecting thumbnails for an operation like Edit-Delete or Edit-Cut is 
shown in the following table. Here we show making the selections using a mouse but you 
can also use the keyboard to perform the same operations. 
 
Action Description 
Click Selects one thumbnail 
Shift Click Selects all thumbnails from current selection to the current 

thumbnail being clicked 
Ctrl Click Allows you to select multiple thumbnails not always in a contiguous 

order 
 

Table XXX Selecting Thumbnail using a mouse 
 
Once you have selected thumbnail images you will want to do one of the following 
editing operations. 
 
Action Description 
Cut Copy all marked thumbnails to the clipboard 
Paste Paste the images stored on the clipboard after the current selection 

point 
Delete When you press the delete key on the keyboard all thumbnails and 

their associated images are removed 
  
 
 

4.1.2 Using the Keyboard 
 
Key Description 
Home Move to the first image in the current thumbnail window 
End Move to the last image in the current thumbnail window 
Ctrl + Home Move to the first thumbnail of all thumbnails 
Ctrl + End Move to the last thumbnail of all thumbnails 
 Move up one row and one column 
 Move down one row and one column 
 Move right one column with wrapping 
 Move left one column 
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Delete Delete the currently selected image. Ask for confirmation 
Page Up Shows the previous set of thumbnail. For example suppose you 

have 50 thumbnails total and can see 10 thumbnails in the 
thumbnail window and the top thumbnail is 30. After you press 
the Page Up key the top thumbnail will be 20. 

Page Down Shows the next set of thumbnail. For example suppose you have 
50 thumbnails total and can see 10 thumbnails in the thumbnail 
window and the top thumbnail is 30. After you press the Page 
Up key the top thumbnail will be 40. 

ESC Pressing the Escape key will un-select all selected images that 
were going to get cut. 

Ctrl+a Select all the thumbnails 
Ctrl+x Cut the selected thumbnails 
Ctrl+v Paste the selected thumbnails 
Ctrl+spacebar Selects the current cursor thumbnail 
Shift+ Selects all thumbnails from current cursor down one row to 

same column and updates the cursor position 
Shift+ Selects the next thumbnail 
 
 

4.2 Status 
The status bar located in the lower right corner shows a gas gauge that indicates the 
progress of the optical character recognition process. To the right of the gas gauge you 
may see messages from the program after an event. For example “file uploaded to rms”. 

4.3 Toolbars 
There are several toolbar buttons that can be turned on or off using the View – Toolbars 
menu 

4.3.1 Scanner Control 
The following table shows the buttons that control the scanner operation. 
 
Icon Name Description 

 
Start Start scanning pages  Please make center green 

 
Stop Stop scanning pages Please make center red 

   
 

4.3.2 Image Control 
The following table shows the buttons that control the image view, image processing the 
current image or merging the vector drawings with the scanned image. 
 
Icon Name Description 
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Settings This activates the image processing side panel settings 

 
Save Merge vector drawing with scanned image 

 
Fit page Fit the scanned image into the current viewing area 

 
Fit width Fit the width of the scanned image into the current 

viewing area 

 
Fit height Fit the height of the scanned image into the current 

viewing area 

 
Rotate -90 Rotate the document -90 degrees (counter clockwise) 

 
Rotate 180 Rotate the document -180 degrees. Document was 

scanned upside down. 

 
Rotate +90 Rotate the document 90 degrees (clockwise) 

 

4.3.3 Drawing 
The drawing tools allow you to add vector drawings to the current scanned image. Note 
that some of the buttons are settings (e.g. line thickness) 
 
Icon Name Description 

 Object Select This allows you to select one drawing object by 
clicking on some part of the object 

 
Pan This allows you to move the whole scanned image by 

dragging the hand. 

 
Zoom You can drag the magnifying glass on an area you want 

to enlarge. 

 Area Selection Drag this rectangle over an area to select the drawing 
objects that are contained within the border of the area 
selection rectangle. 

 Text Place text on the scanned image 

 
Line  Draw straight lines. Note you can set the line thickness, 

line color and end arrows with the line property 
buttons. 

 Pencil This allows you to draw free form lines. The color and 
line thickness are set with the line color and line 
thickness button. 

 Picture You can add a bitmap picture file from any computer 
folder you can access on the current scanned image. 

 
Rectangle This draws a rectangle with a solid color. 

 
Font Property This button sets all the text font properties (font, size, 

color, italics and bold). 

 Fill Color This button sets the fill color. 

 Line Color This button sets the line color. 

 Line Thickness This button sets the line thickness. 
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Line Arrows This button sets the line arrow heads at start and end of 

the line. 
 
 

5 Preparing a Document for Scanning 
Before you start any scanning you have to prepare documents for the scanner. This will 
save you so much time in the long run that is well worth the effort.  
 
First go through the document and remove the following items shown in the next table. 
You want to remove anything that might jam in the scanner. 
 

 
  

 
NO STAPLES NO CLIPS NO CLIPS NO POST ITS 

 

 
  

NO TAPE NO BIG STAINS NO FOOD NO ENVELOPES 
 
Make sure that the pages are not bent or to wrinkled. This may take some rolling or you 
might have to flatten the document by placing a large weight on top for a couple of hours. 
 
You want to go through the document and make sure that each page is separate and is not 
stuck to another page. A common technique is to fan the pages. You grab one side of the 
document and then on the other slide your thumb trying to separate the pages.  
 
Unfold any pages like maps, diagrams or large spread sheets. 
 
Look for very thin paper if you are scanning old documents. These should be done on a 
flat bed scanner and manually inserted. 
 
If you do have to tape objects like small receipts or checks to a page make sure you only 
tape on one side of the paper and the object is centered on the page. Make sure the tape is 
firmly pressed down and you should have at least one piece of tape on the top side. 
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6 Scan to Local Storage 
When you scan a document that you want to save on your local hard drive you first 
prepare the document for scanning and feed the document into your scanner.  
 
Under the Scan Tab choose File Settings and then click the location tab. You want to 
make sure the Base Directory is set to where you want your documents to go.  
 

 
 
 
Then click the green triangle button  located at the bottom left of your display screen. 
The scanner will start scanning and create thumbnails. You may see the following dialog 
box if you have any barcodes on the page. Just click the Submit button.  
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When all the sheets in the document have been scanned you want to make sure that the 
“Done scanning – Save File” radio button is selected. 
 

 
 
Click the Submit button and the system will prompt you for a directory location.  
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7 Scan to RMS Web Server 
Before you can scan a document to the web you have to create a cover sheet which is 
described in the Label program documentation. You also need to have the file settings 
correct. This is in the Scan Menu File settings. Please contact RCO when you do the web 
setup and they will provide you with the strings needed in you Upload and Download 
tabs. This information will allow you to save documents to the web and also read and edit 
documents already on the web. 
 
You need to set the Download tab. 
 

 
 
 
You also have to set the upload tab. 
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Once you have the tabs setup then you add a cover sheet to your document. You will see 
a cover dialog appear after the cover sheet is scanned. 
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If you need to make changes then click the Make changes and keep scanning radio button 
and then click the submit button.  
 
If everything is good (all the information in the edit boxes match the cover sheet) then 
check the All detection data is good and keep scanning radio button and then click the 
submit button. 
 
When you get to the end of the document the system will display the end dialog  
 

 
 
 
You should click the Done scanning – Process and upload. At this point the system will 
assemble the PDF and upload the document to the correct web address. Depending on the 
speed of your connection and the size of the document this can take time. 
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8 Scan to Sharepoint 
Sharepoint is a Microsoft electronic content management software package. You can scan 
PDF documents to any Sharepoint site and add coding (columns) for each document. 
 
To setup scanning to sharepoint you want to start the scan program and select the scan 
menu command as shown in the following figure. 
 

 
 
You want to click on the File Settings… menu selection and you will see the following 
figure which you need to fill out the settings. On the Sharepoint server you have to give 
the user permissions to add documents to the selected site. 
 
The domain is the used to identify your company’s central resources that you have access 
to just like when you log on to your machine or network.  
 
DOMAIN\UserId 
Password 
 
You need to choose the Site where you want your documents stored. Click on the Browse 
button to see the sites. 
 
There is a Test Connection button that helps to verify that you have entered information 
correctly into all the edit boxes. 
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9 Annotate a Document 
Sometimes you have scanned a document but then you need to add or remove a few 
pages. Under the File menu choose the Open local document and you will see the Open 
Document dialog (left side). Click the Browse button and you will see the Open dialog on 
the right. Pick your file and click the Open Button. Then click the Submit button and the 
program will read your file.  
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You can then click on a thumbnail where you want to add pages and then choose Scan 
Insert and Append commands. You can also use the Edit menu to pick various commands 
to delete pages or cut and paste them to different locations within the document. 
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10 Security 
You can use encryption to protect a document. Under the Scan Menu select the File 
setting and then click the Security tab from the following dialog. 
 

 
 
You have to check the Enable box and add the SAME password in both the Key and 
Confirm boxes. Note you have to use the same case since the password is case sensitive. 
You must remember the key! 
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11 Stamp a Document 
If you only have one document to stamp first use the Stamp application to design a stamp 
template.  Under the scan menu File menu choose the File settings command and then 
click the stamp tab. You will see the following dialog.  
 
*** Note that if you have many documents to stamp especially Bates Stamp then we 
suggest that you do the following. First do your normal scanning. Then organize all your 
documents that you want to stamp in a production folder. You can have sub folders. Then 
use the stamp program to stamp all the documents at once. 
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12 Special Operations (OCR) 
Optical Character Recognition known as OCR for short provides several advantages. 
Some copy machines produce PDF files but they are only images and you can do a full 
text search to find words. Scan Pro takes these PDF files and makes them searchable. If 
you have every done data entry for quick books you may have wondered if there was a 
faster way to enter invoices that have line items. Scan Pro simplifies the data entry 
process. 
 
While you may have to design ocr zone templates for your various bills and invoices the 
effort is worth the reward in less typing and more accurate data entry. In the following 
sections you will learn how to create templates, checking data entry coding, upload to 
QuickBooks and also how to convert copy machine PDF files to searchable PDF files. 

12.1 Working with OCR Zones 
The primary purpose of the zone ocr system is to enable you to convert paper bills and 
get them entered into your Quick Book accounting system. In order to use the zone ocr 
process you have to do a few steps. 
 

1. Create zone ocr templates names for each type of bill you receive.  
2. Draw all the zones for a given template and give each zone a name (e.g. Amount) 
3. Do the Zone OCR operation and make corrections if needed. 
4. Upload the information to Quick Books 

 
Once you get the template structure and the zones created from then on you will just open 
the template you want, check the OCR process and upload the information. There is a 
zone ocr toolbar that has buttons that will do you most common functions. 
 
Icon Name Description 

 Design Mode When design mode is selected each rectangular zone 
drawn will be names with text box control 

 New Folder Create a new folder in the templates directory window 
 New Template Create a new zone ocr template 

 Find Template Find an item in the templates directory 

 Delete item Delete item selected in templates directory window 

 Quickbooks 
Upload 

Upload the coding information to quickbooks and 
create invoices 

 
Templates 
Directory 

Show / Hide the templates directory window 

 Coding 
Window 

Show / Hide the coding window 

 
Process Zones Ocr each zone on the current image and add to the 

coding page 
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12.2 Creating Zone OCR Templates 
To create a zone ocr template click the design mode button in the toolbar . This will 
open the template directory window. You have to create at least one folder to hold your 
templates by clicking the new folder button in the toolbar . You create a zone ocr 
template by clicking the new template button in the toolbar . A template must be 
created in a folder. You can delete anything in the template directory by clicking the 
delete icon in the toolbar . ***Note be careful if you delete a folder with many 
templates as these will also be delete all the items contained in the folder. The system 
will prompt you with a dialog asking if you are sure. 
 
 
 
 
To create a zone template you will use the following dialog which is activated from the 
File Menu / OCR Templates. 
 

 
 
 
All OCR templates are stored in sub folders under the folder ZoneOcrTemplates. 
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Once you have created the folder structure for your templates you can select a particular 
folder and then click the create template button.  
 
When you click the create template button the mode combo box located in the toolbar 
will change to design. This indicates that the objects you draw will be names and 
associated with the currently selected template. You can name the zones and then click 
the save template button on the toolbar when you are finished. 
 

12.3 Coding a Zone OCR Template 
When you have a zone ocr template selected and the coding window enabled you will see 
the following figure. The system will start processing the zones and fill in the edit boxes. 
You can manually make changes to the edit boxes and then click save to store the coding 
information in the folder called ZoneOcrCoding. 
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12.4 Working with QuickBooks 
When you the quickbooks button in the toolbar the system will upload all the coding 
information and create invoices. 
 

12.5 OCR a TIFF or PDF 
Sometimes you might want to OCR a TIFF or PDF file that has been produced by a copy 
machine or an application that does not have OCR capabilities. For TIFF files you select 
an item called OCR files in the File menu. If you select this command then you will see 
the following dialog. To OCR a PDF file fir use the open local and save local commands 
in the File menu.  
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First you select the folder you want to process and then add the files in the File in Folder 
list to the Files to be processed list. The > adds one file at a time or you can use the >> to 
add all the files. Click the Start OCR button to start the conversion process. 
 
The following table shows the meaning of all the buttons. 
 
There are several buttons in between the two lists which allow you to add or remove files 
to OCR. The following table shows you the meaning of each button. 
 
Button Name Description 

 
Add All Add all files in the Files in folder list to File to be 

processed list 

 
Add One Add one files in the Files in folder list to File to be 

processed list 

 
Remove All Remove all files in the Files to be processed list 

 
Remove One Remove one files in the Files to be processed list 

 Close Removes the dialog from the display screen 
 Start OCR Start the OCR Conversion process 
 Stop OCR Stops the OCR Conversion process 
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13 Log Files 
The log files help the RCO support staff troubleshoot problems when things go wrong. 
The following table shows the folder location of the log file depending on what windows 
operating system you have. 
 
Operating 
System 

Folder Locations 

XP C:\Documents and Settings\All Users\ScanNet\Debug\ ScanNet.log 
Vista C:\Users\Public\ScanNet\Logs\ Debug\ScanNet.log 
Windows7 C:\Users\Public\ScanNet\Logs\Debug\ScanNet.log 
 
 

14 Summary 
Please contact us at any time if you have problems or suggestions. Most of the product 
improvements come from customer suggestions. 
 
In United States: 800-972-3027 
Outside United States: 310-451-3735 
Email: royn@rco.com 
 
We hope you enjoy the product! 

mailto:royn@rco.com
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